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Part 3.1: Viewing Solicitations
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C

SIGN IN
ORACLE APPLICATIONS CLOUD

User ID

Password

Forgot Password

[English v

Go to DC Water’s Procurement Web Site

1) Open your Internet Browser. CHROME is the preferred web browser for the DC Water application.

2) Go to the DC Water website: https://www.dcwater.com.

3) Click on Work with Us on the menu options then click the Procurement link followed by the DC Water
Supplier Registration link. The page also includes a link for DC Water Supplier Portal log-in and DC
Water Solicitation Abstracts (Solicitation Listing).

4) Enter Your username (contact email) and password
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Good morning, George Washington!

Supplier Portal Tools Others

=]

Supplier Portal <

_|_

Access Supplier Portal

5) Click on the Supplier Portal icon to access the system (including your firm’s profile).
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Supplier Portal

Tasks

Orders
Requiring Attention

* Manage Orders
* Manage Schedules

Agreements

* Manage Agreements
Shipments

* Manage Shipments

* Create ASN

= Create ASBN

* Upload ASN or ASBN 3

* View Receipts

* View Returns M Negoistions Closing Soan

Deliverables

* Manage Deliverables .
Supplier News
Consigned Inventory This is the Supplier News !l

* Review Consumption Advices
* Review Consigned Inventory

* Review Consigned Inventory Transaclions
Invoices and Payments

* Create Invoice
* View Invoices

* View Paymenis
Solicitations

* View Active Solicitations

* Manage Responses
Qualifications

* Manage Quesfionnaires

* View Qualifications
Company Profile

* Manage Profile

Access Solicitations

6)

Click the link “View Active Solicitations”.

District of Columbia Water and Sewer Authority
David L. Gadis, CEO and General Manager

Recent Activity Transaction Reports
Last 30 Days Last 30 Days

No data available No data available
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Active Solicitations

4 Search
** Solicitation
** Title
Step 8 '
* colicitation Close By  m/diyy ry
Search Resulis

Actions v View v Format » Freere ' Detach Wrap | AcceptTerms = Acknowledge Parficipation | Create Response

Solicitation ~ Title

Mo results found.
Columns Hidden 4

Access Solicitations

7) This is the main “Active Solicitations” page.

District of Columbia Water and Sewer Authority
David L. Gadis, CEO and General Manager

Time Zone Eastern Standard Time

Manage Watchlist Saved Search Open Invitations

= At least one is requirsd
** Invitation Received Yes Step 8a
Response Submitted Mo
Solicitation Open Since  midyy T
Search | Reset | Save..
Solicitation Time Your Will Unread .. Response
Type Remaining Close Date Responses Participate Messages View FOF Spreadsheet

8) If you know the solicitation in question, you can type in the box next to “Solicitation”.

8a) If you don’t have a specific solicitation, or if you want to see all open solicitations, please note, they are
organized depending if you received an invitation from the system, or not. You will need to switch between
both by clicking the Yes/No Button next to “Invitation Received” to view all solicitations.

9) Click Search.
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Active Solicitations [ Done |
Time Zone Eastern Standard Time
bSearch Manage Watchlist Saved Search Open Invitations
Search Results
Actions * View v Format v Freeze i Detach Wrap Accept Terms | Acknowledge Parficipation | Create Response
Solicitation  Title ?"#“ﬁﬁ"“ ;ﬁaining Close Date HESW:::S' :‘:Lm m‘:s':::: View PDF S';’r‘f;:s“;:et
DCW-50L-20-1 Green Infrastructura Senices Solicitation Opens in 11day... 10{30/20 1:54 PM 0 ] ;_:
DCW-S0L-20-1 Abstract Check Solicitation 1Day 10Hours  8/26/20 2:02 AM ] 0 ;_:
DCW-50L-20-1 Construction Materials Solicitation 18 Hours 18 Mi...  9/24/20 B:4d AM 0 0 ;_:
DCW-50L-20-1 Gonstruction Materials Solicitation 18 Hours 13 M. 924720 841 AM 0 0 ;_:

DCW-S0L-20-1 RFQ for Chemical Senvices Solicitation 4Days 9Hours Q12820 1254 AM 0 0 B

Access Solicitations

10) When you click search the list of solicitations will appear (in this case we did not look for a specific solicitation) .
11) Select the specific solicitation you are interested in by clicking on the solicitation name.
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Solicitation: DCW-SOL-20-10068

Currency = US Dallar
Title RF(Q for Chemical Services

Status  Active

Time Remaining 4 Days & Hours

Table of Contents Cover Page

Cover Page
Overview
Requirements
Lines

Contract Terms

Access Solicitations

DISTRICT OF COLUMBIA WATER AND SEWER AUTHORITY
(DC WATER)

Request for Quote

for

RFQ for Chemical Services

District of Columbia Water and Sewer Authority
David L. Gadis, CEO and General Manager

g | o ]

Time Zone Easterr,

d Time
OpenDate 914720 1:08 AM

Close Date 92820 12:54 AM

12) When click on the solicitation, you will be taken to the electronic solicitation details.
Note the “Table of Contents” on the left side where you can access the specific details on the solicitation.
12) When you have completed your review, click “Done” to return to the previous page.




Active Solicitations

4 Search
** Solicitation ** Invitation Received Mo
** Title Response Submitted Mo
** Solicitation Close By midiyy Solicitation Open Since  midiyy lig
Search Resulis
Actions w \iew » Format » Freeze }:I Detach Wrap Accept Terms | Acknowledge Participation | Create Response
Solicitation  Title Solicitation  Time Close Date
Type Remaining
DCW-SOL-20-1 Green Infrastructurs: Senvices Solicitation Opens in 11 day... 10/30/20 1:54 PM
DCW-SOL-20-1 Abstract Check Solicitation 1Day 10Hours 25720 2:02 AM
DCW-SOL-20-1 Construction Materials Solicitation 18 Hours 4 Min...  ©24/20 £:48 AM
DCW-SOL-20-1 Construction Materials Solicitation 17 Hours 58 Mi...  @24/20 0:41 AM
N -S0L-20-1 RFQ for Chemical Serviees Solicitation 4Days @ Hows (2820 12:58 AM

) idden 4

Access Solicitations

14) You can keep track of interested solicitations by clicking the “Save” button.
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Time Zone Eastern Standard Time

Manage Watchlist  Saved Search  Open Invitations copy

Your Will
Responses Participate

** At least one i5 required

Search  Reset = Save..

Unread View POF Response

Messages Spreadsheet
] H
0 7
0 i
0 3
] ki

15) If you are interested in submitting a response to the particular solicitation (as a prime) highlight the interested
solicitation and click the “Create Response” button to begin.
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Active Solicitations

Time Zone Eastern Standard Time

Manage Watchlist  Saved Search  Open Invitations copy

5 required

/4 Waming

“Fou must scknowledge sl amendments to solicitation DCW-50L-20-10081 before responding. Do you want to
continue?

Access Solicitations

16) If the solicitation has any active amendments, you will get a prompt from the system to acknowledge them.
17) To review the amendments, and continue, click “Yes”.
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District of Columbia Water and Sewer Authority

David L. Gadis, CEO and General Manager
Acknowledge Amendments (Solicitation DCW-SOL-20-10081) @
g;;;‘:’a:hus el to review and the changes.

View Oniginal Solicitation m

View w Format » Freezz o' Detach Wrap

stern Standard Time
Amendment Title

1 Green

Published Date ~ Status
Columns Hidden 3

Acknowledged Date

1820 356 PM  Freview
Amendment 1: Details

Acknowledgment | have reviewed the changes and | 1 far

itation DCW-S0L-20-10081.
Amendment Description Updating the Open Date fo be posted 3182020 and changing requirement weights.

4 Cover Page

Mo data to display.

A Overview
4 General
4 Schedule

View w Format v Freeze i) Detach Wrap

Field Solicitation DCW-SOL-20-10081 Solicitation DCW-SOL-20-10081,1
Close Date 11MB/20 1:50 PM 10130120 1:54 P
4 Requirements

Mo data to display.

4 Lines

No data to display.

Access Solicitations

18) Clicking “Yes” takes you to the Acknowledge Amendments page.

19) After reviewing them, click the Acknowledgement Box to accept them.
20) Click the “Submit” button to continue.
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L Warning

The amendments to solicitation DCW-30L-20-10081 were acknowledged. You can now create a respons=. Do you want to confinue? (FOM-
20:3533a)

Access Solicitations

21) After clicking Submit, you will get a system generated acknowledgement. This will allow you to continue with the
response submittal.
22) Click “Yes” to continue.
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David L. Gadis, CEO and General Manager
060600

Overv___Requir.. Lines Review

Create Response (Proposal 9048): Overview @

ed H23120 E:15 PM
tern Standard Time
Title G Infrastrucure Services Close Date  10/30/20 1:54 PM
Time Remaining Opens in 11 days 17 howrs
General
Supplier MATIONAL CAPITAL INDUSTRIE Reference Number
Solicitation Currency USD
Note to Buyer
Response Currency  USD
Price Precision 2 Decimals Masimum Attachments None &
4 Contract Terms
4 Variables (3)
Provide values for the listed variables. The values you enter are sutomatically populated in the contract terms.
View v Format » Freeze  Wrap  View Allvariables
Name Description Value Clauses
Mo data to display.
4 Deliverables
Actions » View » Format = Freeze Wrap
Deliverable Name Due Date & ¥ Status
No data to display.

Access Solicitations

23) Clicking “Yes” moves you to the actual solicitation response section. If you are not ready to continue, click “save

and close” to return later.
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Part 3.2: Managing Solicitations

15
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C

SIGN IN
ORACLE APPLICATIONS CLOUD

User ID

Password

Forgot Password

[English v

Go to DC Water’s Procurement Web Site

1) Open your Internet Browser. CHROME is the preferred web browser for the DC Water application.

2) Go to the DC Water website: https://www.dcwater.com.

3) Click on Work with Us on the menu options then click the Procurement link followed by the DC Water
Supplier Registration link. The page also includes a link for DC Water Supplier Portal log-in and DC
Water Solicitation Abstracts (Solicitation Listing).

4) Enter Your username (contact email) and password
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Good morning, George Washington!

Supplier Portal Tools Others

=]

Supplier Portal <

_|_

Access Supplier Portal

5) Click on the Supplier Portal icon to access the system (including your firm’s profile).
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Supplier Portal

Tasks

Orders
Requiring Attention

* Manage Orders
* Manage Schedules

Agreements

* Manage Agreements
Shipments

* Manage Shipments

* Create ASN

= Create ASBN

* Upload ASN or ASBN 3

* View Receipts

* View Returns M Negoistions Closing Soan

Deliverables

* Manage Deliverables .
Supplier News
Consigned Inventory This is the Supplier News !l

* Review Consumption Advices
* Review Consigned Inventory

* Review Consigned Inventory Transaclions
Invoices and Payments

* Create Invoice
* View Invoices

* View Paymenis

Solicitations

* View Active Solicitations
* Manage Responses

Qualifications

* Manage Quesfionnaires

* View Qualifications
Company Profile

* Manage Profile

Manage Responses

6)

Click the link “Manage Responses”.

District of Columbia Water and Sewer Authority
David L. Gadis, CEO and General Manager

Recent Activity Transaction Reports
Last 30 Days Last 30 Days

No data available No data available




District of Columbia Water and Sewer Authority

C

Manage Responses

water is life

Time Zone Eastern Standard Time
4 Search Advanced = Manage Watchlist Saved Search Active or Draft Responses
** At beast one is requirsd
** Solicitation Title ** Response Status Actve or draft

** Solicitation Line Description

** Response

ocks it
Freeze 1 Detach Wrap Accept Terms | Revise

Search = Reset = Save..

Search Results

Revizsing a draft response automz
Acfions » View w Format

Respor L _— . Solicitation Time Unread -
Response Status Solicitation Solicitation Title Type Remaining Messages Monitor
2049 Draft,”, DCW-S0L-20-1...  RFQ for Chemical Services Solicitation 4 Days 4 Hours 0
2048 Draﬂﬂ DCW-50L-20-1...  Green Infrastructure Services Solicitation Opensin 11 day... 0

Columns Hidden 2

Manage Responses

7) This is the main “Manage Responses” page.
8) Note the solicitations that were saved previously (Section 3.1) automatically appear under the Search Results

section. Responses can be worked on for these solicitations.

After reviewing the details of the solicitation, you can determine the best response. The response document
generated will help you provide a complete response by providing all necessary information.

To begin/continue the response process, select the solicitation desired and click “Revise”.
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District of Columbia Water and Sewer Authority
David L. Gadis, CEO and General Manager

Overv... Requir... Lines Review

Create Response (Proposal 9044): Overview (@

General

Supplier
Solicitation Currency
Response Currency

Price Precision

4 Contract Terms

4 Variables (3
Provide values for the listed variables. The values you enter are automafically populated in the contract terms.
View v Format v Freeze Wrap View All variables
Name Description
No data fo display.

4 Deliverables

Actions w View v Format w Freeze

Deliverable Name

Ma data #n dienlou

Title Green Infrastructure Services

Time Remaining Opens in 11 days 4 hours

XYZ Corporation
usbD
usbD

2 Decimals Maximum

Wrap

Manage Responses

11) There are four sections to Submitting a response:

a) Overview Screen
b) Requirements Screen

c) Lines Screen

Last Saved 9/24/20 9:03 AM
Time Zone Eastern Standard Time

Close Date  10/30/20 1:54 PM

Reference Number

Note to Buyer

Attachments None ==

Value Clauses

Due Date & ¥ Status

d) Review Screen
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David L. Gadis, CEO and General Manager
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Overv... Requir.. Lines Review

Create Response (Proposal 9044): Overview (@

Last Saved 9/24/20 9:03 AM
Title Green Infrastructure Services m Close Date  10/30/20 1
Time Remaining Opens in 11 days 4 hours

Time Zone Eastern Standard Time
Supplier XYZ Corporation

General

Reference Number
Solicitation Currency USD

Note to Buyer
Response Currency USD

Price Precision 2 Decimals Maximum Attachments None <

4 Contract Terms

4 Variables (3
Provide values for the listed variables. The values you enter are automafically populated in the contract terms.
View v Format v Freeze Wrap View All variables
Name Description Value Clauses
No data fo display.

4 Deliverables

Actions v View w Format w Freeze Wrap

Manage Responses

12) This is the Response Overview screen. From here, you can:
a) Review the solicitation.
b) Add an attachment.
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Attachments

Aotions = View w = M

* File Name or URL Attached By Attached D=

George Washin...  BZ320 &40 F

>

Step 17 OF | | Cancel

Rows Selected 1  Columns Hidden 1

Manage Responses

13) When you click the “+” to add an attachment, the above pop up screen will appear.
14) To submit the response, select the “Type” of the response (file).

15) Click the “Browse” button to select the file(s) to be uploaded.

16) Once uploaded, Type in a clear title and description of the response.

17) Click “OK”".
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David L. Gadis, CEO and General Manager
- HNONONO,

Overv... Requir... Lines Review

Create Response (Proposal 9048): Overview @

Lasl Saved 9/23/20 9:33 PM
Time Zone Eastern Standard Time
Title Green Infrastructure Services Close Date  10130/20 1:54 P

Time Remaining Opens in 11 days 16 hours
General
Supplier XYZ Corporation Reference Number
Solicitation Currency USD Note to Buyer
Response Currency USD

Price Precisi 2 Deci

Attachments fiyer.pdf = 3¢
4 Confract Terms

4 Variables (@
Provide values for the listed variables. The values you enter are automatically populated in the contract terms.
View v Format v Freeze Wrap View Al variables
Name Description Value Clauses
No data to display.
4 Deliverables
@

Manage Responses

18) Clicking “OK” returns you to the Overview screen.
19) Note the attachment is now added.

20) To continue the response process, click the “Next” button.
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ON - NONO)

Overvi... Requi... Lines Review

Crea Response (Proposa 904 Requiements © ) e e

Last Saved 9/24/20 9:16 AN
ne Zone Eastern Standard Tim

Time Remaining Opens in 11 days 4 hours Close Date  10/30/20 1:54 PM

Section 1. Technical Proposal (Approach) Section 1. Technical Fropo E ,

* 1. REQUIRED RESPONSE. FAILURE TO RESPOND AS REQUESTED BELLOW WILL RESULT IN THE REJECTION OF YOUR
PROPOSAL.

The Scope of Work and Requirements section of this solicitation identifies all required work, requirement, and related requirements.
You must confirm that your firm can and will perform all work specified and can and will meet all requirements identified in this

section.
- Select one of these two drop-down choices: m

1. Can and will meet all requirements. (Also means included in your proposed price.)

2. Can and will meet all requirements with the following exceptions. (Wil be require to attach a document explaining exceptions
Exceptions will not result in the automatic rejection but may or may not result in the lower scoring based on the significance,
determined at the sole discrefion of DC Water. Hint: If you have any exceptions, also propose any alternate or workaround.)

a. Can and will meet all requirements

b. Can and will meet all requirements with the following exceptions

. REQUIRED RESPONSE. FAILURE TO RESPOND AS REQUESTED BELLOW WILL RESULT IN THE REJECTION OF YOUR
PROPOSAL.

Manage Responses

21) Clicking “Next” moves you on to the Requirements screen.
22) This screen outlines all the required documents needed as part of a complete response to the solicitation.

23) You will need to read each requirement, respond as needed, and acknowledge by clicking the appropriate circle.

24) Also note, there may be multiple sections for the requirements. Before moving on, click the drop arrow to the
right to see if there are other sections. (The drop box is also located at the bottom of the page).

25) When you are done, click “Next” to move to the “Lines” screen.
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Create Response (Proposal 9044): Lines @
Currency = US Dollar

Time Remaining Opensin 11 days 4 ho

Actions w  View w  Format w .I‘ Freeze m" Detach Wrap
Line Description
1 Mobilization/Demabilization
2 TYPE -1 WORK: Grit Chamber Coatings and Covers
3 TYPE -1 WORK: PCS - Equipment UPS Upgrade
4 TYPE -1l - TASK SERVICES WORK ALLOWANCES: Emergency Equipments & Materi
5 TYPE -lll - LABOR RATE: General - Foreman
6 TYPE -lll - LABOR RATE: Mech - Millwrights
7 All other work
8 Concrete spall repair J21
9 Concrete spall repair J22

Rows Selected 1 Columns Hidden 8

Grand Totals

All response lines are included
Response Amount  0.00

Manage Responses

26) This is the Lines screen.

ONON - NO)

Lines Review

Required
Details

District of Columbia Water and Sewer Authority

David L. Gadis, CEO and General Manager

Last Saved 9/24/20 9:30 AM
Time Zone Eastern Standard Time

Close Date  10/30/20 1:54 PM

Category Name Response Price UOM

909 Construction, Ir

909 Construction, Ir

909 Construction, Ir

150 Moldings, Meta

909 Construction, Ir

‘909 Construction, Ir

‘909 Construction, Ir

735 Rags and shop

‘909 Construction, Ir

Step 28

Hours

Hours

Linear Feet

Linear Feel

d Esti d Total R

. E: P
Line Amount Quantity Amount Release Amount

2,000

6,000

50

60

27) This screen identifies all the deliverables associated with this program: the line number, Description of the line,

any pertinent details, the related NAIC/NIGP descriptor, unit of measure per line, and estimated quantity.
28) You will need to provide a price per line (based on the unit of measure). The system will calculate the “Line

Amount”. Lines that do not have a value under the UOM column are lump sum lines. Enter your lump sum

price as the response price.

Also note, the grand total amount is calculated at the bottom of the screen.
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Owervi... Requir... Lines Review

Creato Responss (Proposal 9044): Lines @ oo | oo s~ sctons ~ e |

_ Lasl Saved 9/24/20 9:30 AM
Currency = US Dollar Time Zone Eastern Standard Time

Close Date  10/30/20 1:54 PM
Time Remaining Opens in 11 days 4 ho

Actions w  View v Format w " Freeze Wrap
Line Description Category Name Response Price UOM Line Amount Eg::::“en‘; Estimatt'a.d Total Resrgoln&e M'i‘nim“":
1 Mobilization/Demabilization 909 Construction, Ir
2 TYPE -l WORK: Grit Chamber Coatings and Covers 909 Construction, Ir
3 TYPE -l WORK: PCS - Equipment UPS Upgrade 909 Construction, Ir
4 TYPE -l - TASK SERVICES WORK ALLOWANCES: Emergency Equipments & Materi 150 Moldings, Meta
5 TYPE -l - LABOR RATE: General - Foreman 909 Construction, Ir Hours 2,000
[ TYPE -l - LABOR RATE: Mech - Millwrights 909 Construction, Ir Hours 6,000
T All other work 909 Construction, Ir
3 Concrete spall repair J21 735 Rags and shop Linear Feet 50
9 Concrete spall repair J22 909 Consfruction, Ir Linear Feet 80

Rows Selected 1 Columns Hidden &

Grand Totals

All response lines are included.
Response Amount _0.00

Manage Responses

30) Once all your responses have been entered, click “Next” to continue.
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ONORON - |

Overvi__ Requir .. Lines Review
Review Response: Proposal 9044 @ m Respond by Spreadsheet | v m Next
_ View Solicitation Last Saved 9/24/20 10:09 AM
Currency = US Dollar Time Zone Eastern Standard Time
Title Green Infrastructure Services Close Date  10/30/20 1:54 PM View Response PDF
Time Remaining Opens in 11 days 3 hours Validate
Overview Requirements Lines
General
Supplier XYZ Corporation teference Number

Solicitation Currency USD Note to Buyer

Response Currency USD
Price Precision 2 Decimals Maximum Attachments None

Response Valid Until

4 Contract Terms

4 Variables (2
Provide values for the listed variables. The values you enter are automatically populated in the contract terms.
View w Format w Freeze Wrap View All variables
Name Description Value Clauses

Mo data to display.

Manage Responses

31) Clicking “Next” moves you to the “Review” screen. Here you will be able to review all your responses, ensure all

necessary documents are attached and submit. Please note you can navigate between the previous screens
simply by clicking on the corresponding numbers at the top.

Once you are ready to submit, click the “Actions” button and select responses have been entered, click
“Validate” to submit your response.
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Overvi... Requir_. Lines Review

Review Resporse: Proposal 9044 © eror x | N I T -

Last Saved 9/24/20 10:09 AM

Currency = US Dollar Time Zone Eastern Standard Time

¥ou must respond to all lines in the solicitation. (PON-

Title Green Infrastructure Services 2085207) o

Time Remaining Opens in 11 days 3 hours 0K

Overview Requirements Lines

General

Supplier XYZ Corporation teference Number

Solicitation Currency USD Note to Buyer
Response Currency USD
Price Precision 2 Decimals Maximum Attachments None

Response Valid Until

4 Contract Terms

4 Variables (2
Provide values for the listed variables. The values you enter are automatically populated in the contract terms.
View w Format w Freeze Wrap View All variables
Name Description Value Clauses

Mo data to display.

Manage Responses

31) Please note that as a function of the system, you will not be able to complete the process if all responses are not

completed. If you attempt to submit an incomplete package, you will see the above error message.
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District of Columbia Water and Sewer Authority
David L. Gadis, CEO and General Manager

Manage Responses

>

The information you're required to provide can vary between negotiations. If you haven't provided all the required
response information, you will receive an error message when you try to submit your response and be prompted to
supply the missing information.

If the Procurement has alternate lines, you can create a new response line in addition to responding to the
originally defined line. You might want to create an alternate line if you want to offer different price breaks or other
line information. Your additional response line and your response to the original line are both considered when the
category manager analyzes and awards the negotiation.

Generally, a procurement will only allow one response per firm. However, if DC Water allows it, you can create
multiple responses within a round of negotiations. When you create multiple responses, you can offer different line
information (as you can in alternate line responding), and you can also offer different responses to other
negotiation attributes such as requirements, negotiation terms, or contract terms

Contractors can edit their submitted response up to the close date.




